
 

 



 

 



 



 



SwiMP3 Media Manager Importing Existing Songs  

 
1. Open the SwiMP3 Media Manager and go to the “File” Menu and choose “Add/Rescan Tracks to the 
Library” 
2. A window will appear titled “Add Folders.” 
3. Check the check box next to any folders which contain songs you wish to add to your Media Manager 
Library. 
a. Note: Your “My Documents” folder is listed under “C:\Documents and Settings\ [user name] \My 
Documents” where [user name] is your Windows login name. 
4. Once you have selected the folders of music you wish to add to your library click OK. A bar will appear 
across the bottom of your Media Manager screen that will show the progress. 
 

SwiMP3 Media Manager CD Importing 

 

1. Open Media Manager and insert a music CD into your computers CD-ROM drive. 
2. Go to the “Tools” Menu and choose “Rip Audio CD.” Or right click on your CD drive and choose “Rip 
Audio CD” 
3. A window will appear titled “Choose Encoding Destination. 
a. Set the Format to MP3 
b. You can choose where you want your MP3’s to be saved by clicking the folder icon (default location is 
C:\My Music). 
c. Note: Your “My Documents” folder is listed under “C:\Documents and Settings\[user name]\My Documents” 
where [user name] is your Windows login name. 
d. Once you have selected these two options you can click the OK button to begin encoding your songs as MP3. 
A bar will appear across the bottom of your Media Manager screen that will show the encoding progress. 
4. Once the encoding process is complete you can view the songs in your library by clicking any of the 
following icons listed under “Library.” 
a. Title 
b. Artist 
c. Album 
d. Genre 
5. Clicking any of these icons will allow you to view your library sorted by whichever icon you select. 
Example: if you click Artist your library can be viewed with the songs sorted by artist name. 
6. To add songs to your SwiMP3 simply drag a song from the library to the “Finis SwiMP3” icon. Since you 
will probably have duplicates of the songs you have converted, you can look at the “Filename” column to see 
which has the wma and which has the mp3 extension. 
7. You can view the songs which are on your SwiMP3 at any time clicking on the “Finis SwiMP3” icon. 
8. Once you have loaded all desired songs to the SwiMP3 you can right-click on the “Finis SwiMP3” icon and 
choose “Safely remove device.” 
9. 9. It is now safe to unplug your SwiMP3. 
10. 10. To turn on your SwiMP3 hold in the ON/OFF button for two seconds then release. 



SwiMP3 Media Manager Convert WMA to MP3 
 
1. Open Media Manager and select the track you wish to convert. 
2. Go to the “Tools” Menu and choose “Convert Audio Format.” 
3. A window will appear titled “Choose Encoding Destination. 
a. Set the Format to MP3 
b. You can choose where you want your MP3’s to be saved by clicking the folder icon (default location is 
C:\My Music). 
c. Note: Your “My Documents” folder is listed under “C:\Documents and Settings\[user name]\My Documents” 
where [user name] is your Windows login name. 
d. Once you have selected these two options you can click the OK button to begin encoding your songs as MP3. 
A bar will appear across the bottom of your Media Manager screen that will show the encoding progress. 
4. Once the encoding process is complete you can view the songs in your library by clicking any of the 
following icons listed under “Library.” 
a. Title 
b. Artist 
c. Album 
d. Genre 
5. Clicking any of these icons will allow you to view your library sorted by whichever icon you select. 
Example: if you click Artist your library can be viewed with the songs sorted by artist name. 
6. To add songs to your SwiMP3 simply drag a song from the library to the “Finis SwiMP3” icon. Since you 
will probably have duplicates of the songs you have converted, you can look at the “Filename” column to see 
which has the wma and which has the mp3 extension. 
7. You can view the songs which are on your SwiMP3 at any time clicking on the “Finis SwiMP3” icon. 
8. Once you have loaded all desired songs to the SwiMP3 you can right-click on the “Finis SwiMP3” icon and 
choose “Safely remove device.” 
9. It is now safe to unplug your SwiMP3. 
10. To turn on your SwiMP3 hold in the ON/OFF button for two seconds then release. 



SwiMP3 Walkthrough for Windows iTunes 
 
1. Plug your SwiMP3 in; it will be displayed in your “My Computer” as “Removable Disk.” 
2. Open iTunes. 
3. Select “Preferences” from the Edit menu. 
4. Click on the Importing section. (this may be located under the "Advanced" tab) 
5. Select “MP3 Encoder” from the “Import Using” menu. 
6. Click OK. 
7. Now you have two options. 
a. To start from a new CD, insert CD and click “Import” in the top right corner of iTunes. 
b. To convert songs you have already imported into your library as AAC format; Right click on a song. Select 
“Convert Selection to MP3” from the menu that appears. This will create a duplicate file that is MP3 format. 
8. To tell the difference between the original AAC and the MP3 copy of each song, you can either right click 
the song and choose Get Info, or if you right click on the library column headings (Title, Artist, Album, Genre, 
Time) you will get a long list of potential columns you can show in your library, you will want to choose 
“Kind” this column will show the format of your songs, either way you will want to only add songs that show as 
MPEG audio files. 
9. Now you can either drag songs from iTunes to your SwiMP3 drive; or you can drag songs directly from the 
hard drive. Your iTunes songs will be located on you’re My Music folder in the following directory. My 
Music/Itunes/Itunes Music. Within the iTunes Music folder there will be subfolders named after the Artist’s 
name; within the Artist folder there will be Album folder(s). The Album folders will contain the songs and may 
contain duplicates of any songs converted to MP3 from AAC. 
10. Once you have copied all the songs you want you can safely remove the “USB Mass Storage Device” 
11. It is now safe to unplug your SwiMP3. 



SwiMP3 Walkthrough for MAC iTunes 
 
1. Plug your SwiMP3 in; it will be displayed on your desktop as a NO NAME drive. 
2. Open iTunes. 
3. Select “Preferences” from the iTunes menu. 
4. Click on the Importing section. (this may be located under the "Advanced" tab) 
5. Select “MP3 Encoder” from the “Import Using” menu. 
6. Click OK. 
7. Now you have two options. 
a. To start from a new CD, insert CD, select the CD from the source menu and click “Import” in the top right 
corner of iTunes. 
b. To convert songs you have already imported into your library as AAC format, select “Convert Selection to 
MP3” from the “Advanced” menu. This will create a duplicate file that is MP3 format. 
8. To tell the difference between the original AAC and the MP3 copy of each song, you can either hold control 
on your keyboard and click the song and choose Get Info, or if you hold control on your keyboard and click on 
the library column headings (Title, Artist, Album, Genre, Time) you will get a long list of potential columns 
you can show in your library, you will want to choose “Kind” this column will show the format of your songs, 
either way you will want to only add songs that show as MPEG audio files. 
9. Now you can either drag songs from iTunes to your SwiMP3 drive; or you can drag songs directly from the 
hard drive. Your iTunes songs will be located on your Macintosh HDD in the following directory. Users/(user 
name)/Music/Itunes/Itunes Music. Within the iTunes Music folder there will be subfolders named after the 
Artist’s name; within the Artist folder there will be Album folder(s). The Album folders will contain the songs 
and may contain duplicates of any songs converted to MP3 from AAC. 
10. Once you have copied all the songs you want you can drag the NO NAME drive into the trash to eject the 
SwiMP3. 
11. It is now safe to unplug your SwiMP3. 
 
Changing your Songs. 
When you have decided to change the songs you have loaded on the SwiMP3, remember that after you delete 
songs off the SwiMP3 you will need to empty your trash before the space will become free again. 
 



FAQ – Troubleshooting 

 

Q:  Which file types does the SwiMP3 play?  

 

A: The SwiMP3 will only play MP3 format songs, the new SwiMP3v2 will play MP3 and WMA. If you have 
WMA files they can be converted using the SwiMP3 Media Manager (Media Monkey). If you have AAC files 
they can be converted using iTunes. 

 

 

Q: I like to wear a mask style goggle, are there any that fit the SwiMP3?  

 
A: The new SwiMP3v2 should fit on just about any goggle, so you can easily and quickly attach and detach the 
SwiMP3v2 from your mask. 
 
 

Q: What is the maximum depth the SwiMP3 player can reach?  

 
A: Although the SwiMP3 player will be waterproof beyond 10 feet, this is the point at which the water pressure 
prevents the speakers from vibrating enough to transmit sound. 
 
 

Q: What type of batteries does the SwiMP3 utilize?  

 
A: The SwiMP3 comes with a built-in lithium ion polymer rechargeable battery that lasts approximately four 
hours. It is recommended to charge the unit three hours before initial use and for additional recharges. 
 

 

Q: How can I charge my SwiMP3 player without a computer?  

 
A: To charge your SwiMP3 player you will have a buy an adapter. A wall outlet adapter can be purchased from 
our online store. 
 
 

Q: What is the warranty of the SwiMP3?  

 
A: The SwiMP3 has a 90-day warranty. A separate full year warranty may be purchased for $20 upon checkout. 

 

 

Q: My Computer won’t recognize my SwiMP3 player when I plug it in?  

 
A: Press the reset button on the SwiMP3 player while the unit is plugged in. This is the small white button 
above the on/off and in between the green and red LED lights. 
 
 

Q: The green and red lights turn on when I press the ON/OFF button, but turn off when I release it?  

 
A: This may be happening because the SwiMP3 can not read the files on your player. Make sure you don’t have 
folders on your SwiMP3 and confirm that the files loaded onto the SwiMP3 are indeed MP3 files. 
 
 



FAQ – Troubleshooting 

 

Q: When I turn on my SwiMP3 the green light blinks and no songs play?  

 
A: This can mean one of two things:  
If the green light is blinking three times you need to press the NEXT/VOL+ button to initialize the memory. 
Doing this will make the green light blink quickly then turn into a double blink.  
 
If the green light is blinking twice, this means the unit is empty or can not read the files on your SwiMP3; make 
sure you don’t have folders on your SwiMP3 and confirm that the files loaded onto the SwiMP3 are indeed 
MP3 files. 
 
 

Q: I need to format my SwiMP3 player but it won’t turn on so that I may do so?  

 
A: Connect your SwiMP3 player to your computer. Once it is recognized by your computer open up the "My 
Computer" window, right click on your SwiMP3 which should be listed as "Removable Disk". When the menu 
appears as a result of your right click, choose "Format". The format window will appear. Make sure you that the 
file system is "FAT" not "FAT32". Once you have selected the right file system, click the "Start" button to 
begin the format. A window will appear to confirm that formatting will delete all files from your SwiMP3 
player. Click "OK" and the format will begin. Once the format is complete you can load songs back to your 
SwiMP3 player. 
 
 

Q: The cap that covers the USB port on my SwiMP3 came off during my swim, will this damage my 

player?  

 
A: No, the SwiMP3's USB port is completely waterproof, the cap is there to keep the USB port generally dry so 
you wont have to dry it by hand before connecting it to your computer. 
 
 

Q: After a long workout the volume of my SwiMP3 begins to decrease?  

 
A: A decrease of volume during playback is an indication that your battery life is low and the unit will need to 
be recharged soon. 
 
 

Q: When I try to turn the volume up or down the SwiMP3 changes the song?  

 
A: To change the volume level you must hold the NEXT/VOL+ or the PREV/VOL- until desired volume is 
reached. 
 
 

Q: How do I pause song playback?  

 
A: To pause the SwiMP3 player press the NEXT/VOL+ and the PREV/VOL- buttons at the same time. On the 
SwiMP3v2 you can pause playback by pressing the ON/OFF button quickly. 
 
 

Information and Materials found in this document have been obtained from FinisInc.com 


